Laboratory - OSPF: Open Shortest Path First (A Routing Protocol Based on the Link-State Algorithm)
Laboratorijska vježba - protokol usmjeravanja na temelju Link-State Algoritma-OSPF: (Open Shortest Path First) usmjeravanje izborom najkraćeg puta 

Objective

1.1.
Cilj

The objective of this lab is to configure and analyze the performance of the Open Shortest Path First (OSPF) routing protocol.¸
Cilj ove laboratorijske vježbe je podesiti i analizirati performanse protokola usmjeravanje izborom najkraćeg puta (OSPF)
Overview
Pregled

In Lab 6 we discussed RIP, which is the canonical example of a routing protocol built on the distance-vector algorithm. Each node constructs a vector containing the distances (costs) to all other nodes and distributes that vector to its immediate neighbors. Link-state routing is the second major class of intra-domain routing protocol. The basic idea behind link-state protocols is very simple: Every node knows how to reach its directly connected neighbors, and if we make sure that the totality of this knowledge is disseminated to every node, then every node will have enough knowledge of the network to build a complete map of the network.
U Lab 6 proučavali smo RIP-protokol, koji je kanonski primjer protokola usmjeravanja izgrađenog na temelju algoritma vektora udaljenosti. Svaki čvor konstruira vektor koji sadrži udaljenosti (troškove) za sve ostale čvorove i distribuira taj vektor svojim neposrednim susjedima. Link-state usmjeravanje je druga glavna klasa unutar domene protokola usmjeravanja. Osnovna ideja link-state protokola je vrlo jednostavna: Svaki čvor zna kako doći do svoga izravno povezanog susjeda, a ako smo sigurni da je ukupnost tih znanja raširena na svaki čvor, tada će svaki čvor imati dovoljno znanja o mreži za izgraditi kompletnu kartu mreže.
Once a given node has a complete map for the topology of the network, it is able to decide the best route to each destination. Calculating those routes is based on a well-known algorithm from graph theory - Dijkstra's shortest-path algorithm.
Čim određeni čvor ima kompletnu kartu  topologije mreže, on je u stanju odlučiti najbolji put do svakog odredišta. Izračun tih ruta temelji se na dobro poznat algoritmu iz teorije grafova – Dijkstraov algoritam najkraćeg puta (Dijkstra's shortest-path algorithm)
OSPF introduces another layer of hierarchy into routing by allowing a domain to be partitioned into areas. This means that a router within a domain does not necessarily need to know how to reach every network within that domain — it may be sufficient for it to know how to get to the right area. Thus, there is a reduction in the amount of information that must be transmitted to and stored in each node. In addition, OSPF allows multiple routes to the same destination to be assigned the same cost and will cause traffic to be distributed evenly over those routers.
OSPF uvodi još jedan sloj hijerarhije u usmjeravanje dopuštajući domeni da bude podijeljena u područja. To znači da router unutar domene ne mora nužno znati kako doći do svake mreže unutar te domene – Za njega može biti dovoljno znati kako doći do pravog područja. Dakle, radi se o smanjenju količine informacija koje moraju biti prenesene i spremljene u svakom čvoru. Osim toga, OSPF omogućava višestruke rute koje se dodjeljuju za ista odredišta iste cijene te uzrokuje ravnomjerno raspoređen promet nad tim routerima.
In this lab, you will set up a network that utilizes OSPF as its routing protocol. You will analyze the routing tables generated in the routers and will observe how the resulting routes are affected by assigning areas and enabling load balancing.
U ovoj laboratorijskoj vježbi ćete postaviti mrežu koja koristi OSPF kao protokol usmjeravanja. Analizirati će te generirane tablice usmjeravanja u usmjerivaču i promatrati kako dodjeljivanje područja utječe na rezultirajuće rute i omogućuje balansiranje opterećenja.
Prelab Activities
Predlaboratorijske Aktivnosti
Read sections 4.2.3 and 4.2.4 from "Computer Networks: A Systems Approach", 4th Edition.
Pročitajte sekcije 4.2.3 i 4.2.4 iz "Računalne mreže: sustavni pristup", 4. izdanje.
Go to www.net-seal.net/animations.php
 and play the following animation:
Idite na www.net-seal.net/animations.php i pokrenite sljedeće animacije:
Routing and forwarding
.
Procedure
Posupak
Create a New Project
Napravite novi projekt
Start OPNET IT Guru Academic Edition ( Choose New from the File menu.
Pokrenite OPNET IT Guru Academic Edition ( Odaberite New from the File menu
Select Project and Click OK ( Name the project <your initials>_OSPF, and the scenario No_Areas ( Click OK.
Odaberite Project i Kliknite OK ( Imenujte projekt <Vaši inicijali>_OSPF, i scenario No_Areas ( Kliknite OK.
In the Startup Wizard: Initial Topology dialog box, make sure that Create Empty Scenario is selected ( Click Next ( Select Campus from the Network Scale list ( Click Next three times ( Click OK.
U Startup Wizard: Initial Topology dijaloškom okviru, pobrinite se da je Create Empty Scenario odabran ( Kliknite Next ( Odaberite Campus from the Network Scale list ( Kliknite Next tri puta ( Kliknite OK.
Create and Configure the Network
Stvaranje i konfiguriranje mreže
Initialize the Network:
Inicijalizirajte mrežu
The Object Palette dialog box should now be on top of your project workspace. If it is not there, open it by clicking 
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. Select the routers item from the pull-down menu on the object palette.
Dijaloški okvir Object Palette sada bi trebao biti na vrhu vašeg radnog prostora. Ako se on ne nalazi tamo otvorite ga klikom na. 
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 Odaberite routers stavku s padajućeg izbornika na paleti objekt.
Add to the project workspace eight routers of type slip8_gtwy. To add an object from a palette, click its icon in the object palette. ( Move your mouse to the workspace and click to place the object. ( You can keep on left-clicking to create additional objects. Right-click when you are finished placing the last object.
Dodaj u radni prostor osam usmjerivač tipa slip8_gtwy. Da biste dodali objekt iz palete, kliknite na njegovu ikonu u paleti objekt. ( Premjestiti Vaš pokazivač u radni prostor i kliknite na mjesto objekta. ( Možete lijevom tipkom miša kliknuti na stvaranje dodatnih objekata. Desnom tipkom miša kliknite kad ste završili postavljanje posljednjog objekta.
Switch the palette configuration so it contains the internet_toolbox. Use bidirectional PPP_DS3 links to connect the routers. Rename the routers as shown below.
Uključite palete konfiguraciju tako da sadrži internet_toolbox. Koristite dvosmjerne PPP_DS3 veze za povezivanje routera. Preimenujte usmjerivače kao što je prikazano u nastavku.
Close the Object Palette and then save your project.
Zatvorite Objekt Palette, a zatim spremite projekt.
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The slip8_gtwy node model represents an IP based gateway supporting up to eight serial line interfaces at a selectable data rate. The RIP or OSPF protocols may be used to automatically any dynamically create the gateway’s routes in an adaptive manner.
slip8_gtwy čvor model predstavlja IP baziran gateway koji podržava do osam serijskih sučelja kod odabira brzine prijenosa. RIP ili OSPF protokoli se mogu koristiti za automatske bilo koje dinamički stvorene prolazne rute na prilagođen način.
The PPP_DS3 link has a data of 44.736 Mbps.
PPP_DS3 link ima brzinu od 44,736 Mbps.
Configure the Link Costs:
Konfiguriranje Link Troškova:

We need to assign link costs to match the following graph:
Moramo dodijeliti link troškova kako bi odgovarao sljedećem grafu:
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Like many popular commercial routers, OPNET router models support a parameter called a reference bandwidth to calculate the actual cost, as follows:
Poput mnogih popularnih komercijalnih usmjerivača OPNET modeli usmjerivača podržavaju parametar naziva reference bandwidth za izračun stvarnih troškova, kako slijedi:
Cost = (Reference bandwidth)/(Link bandwidth)
Trošak = (Referentna propusnost) / (Link propusnost)
where the default value of the reference bandwidth is 1,000,000 Kbps.
gdje je zadana vrijednost referentne propusnosti 1.000.000 Kbps.
For example, to assign a cost of 5 to a link, assign a bandwidth of 200,000 Kbps to that link. Note that this is not the actual bandwidth of the link in the sense of transmission speed, but merely a parameter used to configure link costs.
Na primjer, dodijeliti cijenu od 5 za link, dodijeliti propusnost od 200.000 Kbps za taj link. Imajte na umu da to nije stvarna propusnost linka u smislu brzine prijenosa, već samo parametar koji se koristi za konfiguriranje troska linka.
To assign the costs to the links of our network, do the following:
Za dodjelu troška linkova naše mreže, učinite sljedeće:
Select all links in your network that correspond to the links with a cost of 5 in the above graph by shift-clicking on them.
Odaberite sve linkove u vašoj mreži koji odgovaraju linkovima s troškom od 5 na gornjem grafikonu pomicanjem i klikom na njih.
Select the Protocols menu ( IP ( Routing ( Configure Interface Metric Information.
Odaberite Protocols izbornik (IP ( Routing ( Configure Interface Metric Information.

Assign 200,000 to the Bandwidth (Kbps) field ( Check the Interfaces across selected links radio button, as shown ( Click OK.
Dodjelite 200.000 u Bandwidth (Kbps) polje ( Provjerite sučelja preko odabranih links radio gumb, kao što je prikazano ( Kliknite OK.
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Repeat step 4 for all links with a cost of 10 but assign 100,000 Kbps to the Bandwidth (Kbps) field.
Ponovite korak 4 za sve linkove s troškom od 10, ali dodijelite 100.000 kbps u Bandwidth (Kbps) polja.
Repeat step 4 for all links with a cost of 20 but assign 50,000 Kbps to the Bandwidth (Kbps) field.
Ponovite korak 4 za sve linkove s troškom od 20, ali dodijelite 50.000 kbps u Bandwidth (Kbps) polja.
Save your project.
Spremite projekt.
Configure the Traffic Demands:
Konfiguriranje Traffic Demands:
Select both RouterA and RouterC by shift-clicking on them.
Odaberite oba RouterA i RouterC klikom na njih.
Select the Protocols menu ( IP ( Demands ( Create Traffic Demands ( Check the From RouterA radio button as shown ( Keep the color as blue ( Click Create. Now you should see a blue-dotted line representing the traffic demand between RouterA and RouterC.
Odaberite Protocols izbornik ( IP ( Demands ( Create Traffic Demands ( Check the From RouterA radio button kao što je prikazano ( Zadržite plavu boju ( Kliknite Create Sada biste trebali vidjeti plavu točkastu liniju koja predstavlja prometne zahtjev između RouterA i RouterC.
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Select both RouterB and RouterH by shift-clicking on them.
Odaberite oba RouterB i RouterH klikom na njih.
Select the Protocols menu ( IP ( Demands ( Create Traffic Demands ( Check the From RouterB radio button ( Change the color to red ( Click OK ( Click Create.
Odaberite Protocols izbornik menu ( IP ( Demands ( Create Traffic Demands ( Check the From RouterB radio button ( Promijenite boju u crvenu ( Kliknite OK ( Kliknite Create.

Now you can see the lines representing the traffic demands as shown.
Sada možete vidjeti crte koje predstavljaju zahtjeve prometa kao što je prikazano.
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To hide these lines: Select the View menu ( Select Demand Objects ( Select Hide All.
Da biste sakrili ove linije: Odaberite View izbornik ( Select Demand Objects ( Select Hide All.

Save your project.
Spremite projekt.
Configure the Routing Protocol and Addresses:
Konfiguriranje protokola usmjeravanja i adresa:
Select the Protocols menu ( IP ( Routing ( Configure Routing Protocols.
Odaberite Protokoli izbornik ( IP ( Routing ( Configure Routing Protocols
Check the OSPF check box ( Uncheck the RIP check box ( Uncheck the Visualize Routing Domains check box, as shown:
Potvrdite OSPF u potvrdni okvir box ( Ponistite the RIP u potvrdnom okviru ( Poništite the Visualize Routing Domains u potvrdnom okviru, kako je prikazano:
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Click OK.
Select RouterA and RouterB only ( Select the Protocols menu ( IP ( Routing ( Select Export Routing Table for Selected Routers ( Click OK on the Status Confirm dialog box.
Odaberite samo RouterA i RouterB ( Odaberite Protocols menu ( IP ( Routing ( Select Export Routing Table for Selected Routers ( Kliknite OK na Status Confirm dialog box.
Auto-Assign IP Addresses assigns a unique IP address to connected IP interfaces whose IP address is currently set to auto-assigned. It does not change the value of manually set IP address.
Auto-dodijeliti IP adrese dodjeljuje jedinstvenu IP adresa za povezivanje IP sučelja čija je IP adresa trenutno postavljena na auto-dodijeljena. To ne mijenja vrijednost ručno postavljene IP adresu.
Configure the Simulation
Konfiguriranje simulacije
Here we need to configure some of the simulation parameters:
Ovdje moramo konfigurirati neke parametre simulacije:
Click on 
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 and the Configure Simulation window should appear.
Kliknite na 
[image: image10.png]


 i prozor Configure Simulation bi se trebao pojaviti
Set the duration to be 10.0 minutes.
Postavite trajanje na 10,0 minuta.
Click OK and then save your project.
Kliknite OK i spremite projekt.
Duplicate the Scenario
Udvostručite Scenarij
In the network we just created, all routers belong to one level of hierarchy (i.e., one area). Also, we didn't enforce load balancing for any routes. Two new scenarios will be created. The first new scenario will define two new areas in addition to the backbone area. The second one will be configured to balance the load for the traffic demands between RouterB and RouterH.
U mreži koju smo upravo stvorili, svi usmjerivači pripadaju jednoj razini hijerarhije (tj. jedno područje). Također, nismo proveli balansiranje opterećenja za bilo koju rutu. Kreirat ćemo dva nova scenarija. Prvi novi scenarij definirat će dva nova područja uz okosnicu područja. Drugi će biti konfiguriran tako da se balans opterećenja za zahtjev prometa između  RouterB i RouterH.
The Areas Scenario:
Areas Scenario:
Select Duplicate Scenario from the Scenarios menu and give it the name Areas ( Click OK.
Odaberite Duplicate Scenario iz izbornika Scenariji i imenujtu ga Areas ( Kliknite OK.

Area 0.0.0.1:
Površina 0.0.0.1:
Select the three links that connect RouterA, RouterB, and RouterC by shift-clicking on them ( Select the Protocols menu OSPF ( Configure Areas ( Assign the value 0.0.0.1 to the Area Identifier, as shown ( Click OK.
Odaberite tri linka koja povezuju RouterA, RouterB i RouterC klikom na njih ( Odaberite Protocols menu OSPF ( Configure Areas ( Dodijelite vrijednost 0.0.0.1 to the Area Identifier, kao što je prikazano ( Kliknite OK.
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Right-click on RouterC ( Edit Attributes ( Expand the OSPF Parameters hierarchy ( Expand the Loopback Interfaces hierarchy ( Expand the row0 hierarchy ( Assign 0.0.0.1 to the value of the Area ID attribute ( Click OK.
Desnom tipkom miša kliknite na RouterC Edit Attributes ( Expand the OSPF Parameters hierarchy ( Expand the Loopback Interfaces hierarchy ( Expand the row0 hierarchy ( Dodijelite 0.0.0.1 za vrijednost of the Area ID attribute ( Kliknite OK.

Area 0.0.0.2
Area 0.0.0.2

Click somewhere in the project workspace to disable the selected links and then repeat step 2-i for the three links that connect RouterF, RouterG, and RouterH but assign the value 0.0.0.2 to their Area Identifier.
Kliknite negdje unutar radnog prostora da onemogućite odabrane veze i zatim ponovite korak 2-ja za tri veze koje povezuju RouterF, RouterG i RouterH ali dodijelite vrijednost 0.0.0.2 njihovom Area Identifier.
To visualize the areas we just created, select the Protocols menu ( OSPF ( Visualize Areas ( Click OK. The network should look like the following one with different colors assigned to each area (you may get different colors though).
Kako bismo vizualizirali područja koja ste upravo stvorili, odaberite Protocols menu ( OSPF ( Visualize Areas ( Kliknite OK. Mreža treba izgledati kao što je prikazano na slici dolje s različitim bojama dodijeljenim svakom području (Vi možete odabrati različite boje)
Loopback interface allows a client and a server on the same host to communicate with each other using TCP/IP.
Loopback sučelje omogućava klijentu i poslužitelju na istom domaćinu da komuniciraju jedan s drugim pomoću TCP / IP.
Note:
Napomena:
The area you did not configure is the backbone area and its Area Identifier = 0.0.0.0.
Područje koje niste konfigurirali je okosnica područja i njegova Area Identifier = 0.0.0.0.
The figure shows the links with a thickness of 3.
Slika prikazuje veze s debljinom od 3.
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The Balanced Scenario:
Balanced Scenarij:
Under the Scenarios menu, Switch to Scenario ( Select No_Areas.
Pod Scenarios izbornik, prebacite Scenario ( Select No_Areas.
Select Duplicate Scenario from the Scenarios menu, and give it the name Balanced ( Click OK.
Odaberite Duplicate Scenario iz Scenariji izbornika, i imenujte ga Balanced ( Kliknite OK.
In the new scenario, select both RouterB and RouterH by shift-clicking on them.
U novom scenariju, odaberite RouterB i RouterH klikom na njih.
Select the Protocols menu ( IP ( Routing ( Configure Load Balancing Options ( Make sure that the option is Packet-Based and the radio button Selected Routers is selected as shown ( Click OK.
Odaberite Protocols izbornik ( IP ( Routing ( Configure Load Balancing Options ( Uvjerite se da je opcija Packet-Based i radio gumb Selected Routers odabrana kao što je prikazano ( Click OK.
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Save your project.
Spremite projekt.
OPNET provides two types of IP load balancing.
OPNET nudi dvije vrste IP uravnoteženja opterećenja.
With Destination Based, load balancing is done on a per destination basis. The route chosen from the source router to the destination network is the same for all packets.
S Destination Based, uravnoteženje opterećenja se vrši na osnovu odredišta. Ruta izabrana od izvorišnog usmjerivača do odredišta mreže je ista za sve pakete.
With Packet Based, load balancing is done on a per packet basis. The route chosen from the source router to the destination network is determined for every individual packet.
S Packet Based uravnoteženje opterećenja se vrši na osnovu po paketa. Ruta izabrana od izvorišnog usmjerivača na odredište mreže utvrđuje se za svaki pojedini paket.
Run the Simulation
Pokretanje simulacije
To run the simulation for the three scenarios simultaneously:
Da biste pokrenuli simulaciju za tri scenarija istodobno:
Go to the Scenarios menu ( Select Manage Scenarios.
Idite na izbornik Scenarios ( Odaberite Manage Scenarios.
Click on the row of each scenario and click the Collect Results button. This should change the values under the Results column to <collect> as shown.
Kliknite na redak svakog scenarija te kliknite na gumb Collect Results. To bi trebalo promijeniti vrijednosti ispod Results column to <collect> kao što je prikazano.
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Click OK to run the three simulations. Depending on the speed of your processor, this may take several seconds to complete.
Kliknite OK za pokretanje tri simulacije. Ovisno o brzini vašeg procesora, ovo će potrajati nekoliko sekundi.
After the three simulation runs complete, one for each scenario, click Close and then save your project.
Nakon što se izvrše sve tri simulacije  po jedna za svaki scenarij, pritisnite Zatvori, a zatim spremite projekt.
View the Results
Prikaz rezultata
The No_Areas Scenario:
No_Areas Scenario:
Go back to the No_Areas scenario.
Povratak na No_Areas scenarij.
To display the route for the traffic demand between RouterA and RouterC: Select the Protocols menu ( IP ( Demands ( Display Routes for Configured Demands. ( Expand the hierarchies as shown and select RouterA ( RouterC ( Go to the Display column and pick Yes ( Click Close.
Za prikaz rute prometne potražnje između RouterA i RouterC: Odaberite Protocols menu ( IP ( Demands ( Display Routes for Configured Demands. ( Proširite hijerarhiju kao štoje prikazano i odaberite RouterA ( RouterC ( Idite na Display column i Odaberite Yes ( Kliknite Close.


The resulting route will appear on the network as shown:
Rezultatirajuća ruta će se pojaviti na mreži kao što je prikazano


Repeat step 2 to show the route for the traffic demand between RouterB and RouterH. The route is as shown below. (Note: Depending on the order in which you created the network topology, the other “equal-cost” path can be used, that is, the RouterB-RouterA-RouterD-RouterF-RouterH path).
Ponovite korak 2 kako bi pokazali rutu za potrebe prometa između RouterB i RouterH. Ruta je prikazana u nastavku. (Napomena: Ovisno o redoslijedu kojim ste stvorili topologiju mreže, druga "jednakog-troška" staza se može koristiti, da je, RouterB-RouterA-RouterD-RouterF-RouterH put).




The Areas Scenario:
Areas Scenario:
Go to scenario Areas.
Idi na scenarij Areas.
Display the route for the traffic demand between RouterA and RouterC. The route is as shown:
Prikaz rute za potrebe prometa između RouterA i RouterC. ruta kao što je prikazano:


Save your project.
Spremite projekt.
The Balanced Scenario:
Balanced Scenario:
Go to scenario Balanced
Idi na scenariju Balanced
Display the route for the traffic demand between RouterB and RouterH. The route is as shown:
Prikaz rute za potrebe prometa između RouterB i RouterH. ruta kao što je prikazano:


Save your project.
Spremite projekt.
Further readings
Daljnja čitanja
OPNET Model Usage Guide
.OSPF Model Description
: From the Protocols menu, select OSPF ( 
OPNET OSPF Model Description: U Protocols izborniku odaberi OSPF ( Model Usage Guide.
www.ietf.org/rfc.html
).OSPF: IETF RFC number 2328
 (
Exercises
Vježbe
Explain why, for the same pair of routers, the Areas and Balanced scenarios result in different routes than those observed in the No_Areas scenario.
Objasnite zašto je u scenarijima Areas i Balanced za isti par usmjerivača, rezultirajuća ruta  različita od onih promatranih u No_Areas scenariju.
Using the simulation log, examine the generated routing table in RouterA for each one of the three scenarios. Explain the values assigned to the Metric column of each route.
Korištenjem simulation log, ispitajte generirane tablice usmjeravanja za RouterA za svaki od tri scenarija. Objasnite vrijednosti dodijeljene Metričkom stupcu svake rute.
Hints:
Savjeti:
Refer to the View Results section in Lab 6 for information about examining the routing tables. You will need to set the global attribute IP Interface Addressing Mode to the value Auto Addressed/Export and rerun the simulation.
Pogledajte odjeljak View Results u Lab 6 za informacije o ispitivanju tablica usmjeravanja. Morat ćete postaviti global attribute IP Interface Addressing Mode na vrijednosti Auto Addressed/Export i ponoviti simulaciju.
To determine the IP address information for all interfaces, you need to open the Generic Data File that contains the IP addresses and associated with the scenarios.
Da biste utvrdili informacije IP adresa za sva sučelja, morate otvoriti Generic Data File koja sadrži IP adrese, povezane sa scenarijima.
OPNET allows you to examine the link-state database that is used by each router to build the directed graph of the network. Examine this database for RouterA in the No_Areas scenario. Show how RouterA utilizes this database to create a map for the topology of the network and draw this map (This is the map that will be used later by the router to create its routing table.)
OPNET omogućuje ispitati link-state bazu podataka koju  koristi svaki usmjerivač za izgradnju usmjerenog grafikona mreže. Pregledajte ovu bazu podataka za RouterA u No_Areas scenariju. Pokažite kako RouterA koristi ovu bazu podataka za izradu karte topologije mreže i privuci ove karte (Ovo je karta koju će kasnije koristiti usmjerivač za stvaranje svoje tablice usmjeravanja.)
Hints:
Savjeti:
To export the link-state database of a router, Edit the attributes of the router and set the Link State Database Export parameter (one of the OSPF Parameters, under Processes) to Once at End of Simulation.
Za izvoz link-state baze podataka usmjerivača, Uredi atribute routera i postaviti Link State Database Export parameter (jedan od parametara OSPF, pod procesi) u Once at End of Simulation.
You will need to set the global attribute IP Interface Addressing Mode to the value Auto Addressed/Export. This will allow you to check the automatically assigned IP addresses to the interfaces of the network. (Refer to the notes of exercise 2 above.)
Morat ćete postaviti global attribute IP Interface Addressing Mode na vrijednosti Auto Addressed/Export. To će Vam omogućiti da provjerite automatski dodjeljene IP adrese sučelja mreže. (Vidi bilješke vježbe 2 iznad.)
After rerunning the simulation, you can check the link-state database by opening the simulation log (from the Results menu). The link-state database is available in Classes ( OSPF ( LSDB_Export.
Nakon ponovnog pokretanja simulacije, možete provjeriti link-state bazu podataka otvaranjem simulation log (iz the Results menu). Link-state baza podataka je dostupna u Classes ( OSPF ( LSDB_Export.
Create another scenario as a duplicate of the No_Areas scenario Name the new scenario Q4_No_Areas_Failure. In this new scenario simulate a failure of the link connecting RouterD and RotuerE. Have this failure start after 100 seconds. Read the simulation. Show how that link failure affects the content of the link-state database and routing table of RouterA. (You will need to disable the global attribute OSPF Sim Efficiency. This will allow OSPF to update the routing table if there is any change in the network.)
Napravite još jedan scenario kao duplikat No_Areas scenarija Imenujte novi scenarij Q4_No_Areas_Failure. U ovom novom scenariju simulirajte neuspjeh linka koji povezuje RouterD i RotuerE. Neka ovaj neuspjeh linka počne nakon 100 sekundi. Pročitajte simulaciju. Pokažite kako taj neuspjeh (pogreška) veze utječe na sadržaj link stanja baze podataka i tablice usmjeravanja za RouterA. (Morat ćete onemogućiti global attribute OSPF Sim Efficiency. To će omogućiti OSPF ažuriranje tablica usmjeravanja ako ima bilo kakve promjene u mreži.)
For both No_Areas and Q4_No_Areas_Failure scenario, collect the Traffic Sent (bits/sec) statistic (one of the Global Statistics under OSPF). Rerun the simulation for these two scenarios and obtain the graph that compares the OSPF's Traffic Sent (bits/sec) in both scenarios. Comment on the obtained graph.
Za oba No_Areas i Q4_No_Areas_Failure scenarija, skupite Traffic Sent (bits/sec) statistic (jedan za Global Statistics under OSPF). Ponovno pokrenite simulaciju za ova dva scenarija i dobiti ćete grafikon koji uspoređuje OSPF Traffic Sent (bits/sec) u oba scenarija. Komentirajte dobiveni grafikon.
Note: A stub network only carries local traffic (i.e., packets to and from local hosts). Even if it has paths to more than one other network, it does not carry traffic for other networks (RFC 1983).
Napomena: mreža prenosi samo lokalni promet (tj. Pakete od i prema domaćinu). Čak i ako ima staze za više od jedne mreže, ne prenosi promet za druge mreže (RFC 1983).
Lab Report
Laboratorijsko izvješće
Prepare a report that follows the guidelines explained in Lab 0. The report should include the answers to the above exercises as well as the graphs you generated from the simulation scenarios. Discuss the results you obtained and compare these results with your expectations. Mention any anomalies or unexplained behaviors.
Pripremite izvješće koje prati smjernice objašnjene u Laboratorijskoj vježbi br. 0. Izvješće treba sadržavati odgovore na gore navedene vježbe, kao i grafikone koje ste generirali iz simulacijskih scenarija. Raspravite rezultate koje ste dobili i usporedite ih  s vašim očekivanjima. Navedite bilo kakve anomalije ili neobjašnjiva ponašanja.
� Nikako se ne prikazuje rezultirajuća ruta između usmjerivača ( višestruko sam ponavljao vježbu step by step po uputama iz vježbe ali nikako nemogu dobiti prikaz rezultirajućih ruta, tako da četiri zadnje slike nisam uspio obraditi,
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